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S-LAYER | CREDITS
A GIANT THANK YOU GOES OUT TO THE FOLLOWING ARTISTS WHO CONTRIBUTED TO MAKING 

THE S-LAYER SAMPLE MAP.  PLEASE CHECK OUT THEIR WORK AND SUPPORT THEIR ART.

S-LAYER features sound design and sample content by:

ANTONIO BLANCA | HTTP://WWW.ANTONIOBLANCA.COM/

DELECT | HTTPS://WWW.FACEBOOK.COM/DELECTFAN

EVAC | HTTP://HAPTICAUDIO.COM

GLITCHMACHINES | HTTP://WWW.GLITCHMACHINES.COM

MIKE HUCKABY | HTTPS://WWW.FACEBOOK.COM/MICHAEL.HUCKABY2

JEDSOUND | HTTP://WWW.JEDSOUND.COM/BLOG

MIGUEL ISAZA | HTTP://DESIGNINGSOUND.ORG/

PNORTNAOMI | HTTP://PNORTNAOMI.COM/

RICHARD DEVINE | HTTP://WWW.RICHARD-DEVINE.COM/

SURACHAI | HTTP://SURACHAI.ORG/

TONE BUILDER | HTTP://WWW.DRIVENMACHINEDRUMS.COM/

JOSH HINDEN | HTTP://TWISTEDTOOLS.COM

SONICTWIST | HTTP://TWISTEDTOOLS.COM

The included S-LAYER library is free to use for commercial or non-commercial music, film 
and multi-media works by individuals (single users). You may not redistribute these samples 
in any way, shape or form or claim credit for the material in its raw unaltered form or outside 
of a greater body of work. You may not use this material to make other sample libraries. 
Click here to view the complete End User License Agreement online for this product online.

 Credits

                                                    	 S-LAYER USER GUIDE - PAGE 2

http://livepage.apple.com/
http://livepage.apple.com/
https://www.facebook.com/DelectFan
https://www.facebook.com/DelectFan
http://hapticaudio.com
http://hapticaudio.com
http://www.glitchmachines.com
http://www.glitchmachines.com
https://www.facebook.com/michael.huckaby2
https://www.facebook.com/michael.huckaby2
http://www.jedsound.com/blog
http://www.jedsound.com/blog
http://designingsound.org
http://designingsound.org
http://pnortnaomi.com
http://pnortnaomi.com
http://www.richard-devine.com
http://www.richard-devine.com
http://surachai.org/
http://surachai.org/
http://www.drivenmachinedrums.com/
http://www.drivenmachinedrums.com/
http://www.twistedtools.com
http://www.twistedtools.com
http://www.twistedtools.com
http://www.twistedtools.com
http://twistedtools.com/documentation/Twisted_Tools_EULA.pdf
http://twistedtools.com/documentation/Twisted_Tools_EULA.pdf


LEGAL

All software discussed in this manual is issued as is and the software described in this manual 
comes with no warranty. We are not be responsible for any lost data, hardware problems or 
financial loss incurred as a result of using this software. If you are unsure as to how to use this 
software, don’t use it. Any information in this manual is subject to change without notice and 
nothing in this document represents a commitment on the part of Twisted Tools, LLC.  All the 
software described by this document is copyright Twisted Tools. All product names and company 
names mentioned herein are ™ or registered trademarks of their respective owners. The software 
described by this document is subject to a License Agreement and may not be copied to other 
media. Click here to view the complete End User License Agreement online for this product online 
and read before using the included software or sample content. You may not alter this document in 
any form or distribute it for any purpose other than press related purposes. You may not share this 
software with anyone or any entity, such as torrent sites without violating the terms of use. Should 
you share this software illegally, it is likely that the wrath of god will come down upon you.  Should 
you buy this software, your karma will be plentiful. 

If you somehow magically obtained this software, buy it...at our site.  We need your support to 
keep bringing you more twisted tools. 

Twisted Tools™

San Francisco, CA

USA

 Legal
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TWISTED TOOLS | S-LAYER
USER GUIDE

1. Welcome
Thanks for purchasing S-LAYER. We hope you enjoying using this tool as much as we 
enjoyed making it. 

S-LAYER is a very unique sampler instrument, built around the concept of taking sounds 
and layering them together in clever ways to create new sound combinations. Because 
you can load your own samples, S-LAYER is well suited to any style of music production 
as well as sound design for film, television and games. 

Load up kick drums and S-LAYER will spit out new kick drum variations. Load up 
swooshes and you’ll get more swooshes. Load up a variety of sounds and you’ll get some 
things that truly defy description, but are simply jaw dropping.

The S-LAYER interface is slick and quick to use. A unique and beautiful wave display helps 
to illustrate what you’re hearing. While you can easily just hit random and drag some 
sliders around until you hear something you like, there are over 330 different parameters 
and controls to work with should you choose to edit your sound combinations with 
precision! 

Have fun!

Twisted Tools

1.1. Manual Conventions
This manual uses formatting conventions to point out facts, teach you tips and warn you of 
things.  

The following icons are found throughout this guide:

Important warnings. Always read these!

Notes: Useful notes and relevant additional information.

Tips: Tips and advanced techniques. 

           Welcome
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Videos: Links to relevant videos.

Audio: Links to relevant audio.

Links: Links to other content/websites with relevant info.

Single step instructions will be indicated with an arrow like the one on the left.

The following text formatting is used throughout this guide:

Text appearing in menus (New, Save, etc.) and file paths and file names will be Italic.
Text appearing somewhere on the interface, but not in a main Reaktor menu will be 

highlighted in BLUE. 

Important names, ideas and topic headings will be bold.

Key commands will be in brackets (e.g., “Press [Control]”)

Section links (e.g., links to other sections within the manual) will be indicated like 

this.

1.2. System Requirements
Mac or PC running the full version of Native Instruments Reaktor 5 (5.62 and up). 
Intel Core 2 Duo Processor or better recommended
500MB of RAM
Native Instruments Maschine and/or an iPad with the requisite applications (Lemur, 
Konkreet Performer, etc.) if you plan to use the included templates.

If you’d like to test your system before buying S-LAYER to see if it is fast enough, try the 
FM4 Dual ensemble included with your Reaktor default library. If you’re able to run FM4 
Dual ensemble comfortably and have at least 500MB of RAM, S-LAYER should run 
smoothly, keeping in mind that fast scene switching will require additional CPU.

           Welcome
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1.3. Installation
S-LAYER is a Reaktor ensemble. There is no need to 
install a Reaktor ensemble. They are like Word 
documents, you can put them anywhere and double-
click them to open them or drag them to the Reaktor 
interface to open them.

That said, it is good practice to put them somewhere 
in your default Reaktor USER CONTENT location, 
which you can set in Reaktor > Preferences, within 
the DIRECTORIES tab.

Files that say .ENS should be put in the Ensembles 
sub-folder in your user library. Then you can easily 
browse for them from within the Reaktor browser 
window's user tab.

Files that say .ISM should be put in the Instruments 
sub-folder in your user library. Instruments are the 
main components in an ensemble. 

In most cases, you will want to always use a .ENS file which is finished and ready to use, 
whereas .ISM files are mainly used for building.

            Installation
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2. What is S-LAYER
S-LAYER is a sample layering sound creation tool for Native Instruments *Reaktor 5. It 
allows you to create, edit and play new sound combinations by taking samples and 
layering them together using an eight part sampler and an intuitive cell layout.  By 
combining sounds from the included sample map or your existing sample library, S-LAYER 
facilitates the discovery of new oneshots, sound effects and loops using your pre-existing 
sample content.  Whether you’re looking for a new way to create thick drum samples for 
hip-hop or a massive impact sound effect for game, S-LAYER delivers unique sound 
combinations to suit your needs.

With S-LAYER, up to eight parts are played back and manipulated simultaneously using an 
advanced layered sampler engine, where each layer remains independent and can be 
surgically edited.  Time-tested sound design techniques such as reversing, pitching, 
modulating and mixing sounds together can be quickly achieved by randomizing and fine-
tuning with sliders and knobs. In addition to the on-board granular, filter and time-based 
effects, you can also connect your own effects using the insert/send system or by using 
the direct outputs.  Once you’ve found a sound combination that you like, you can store it 
on-the-fly in one of eight ‘Scenes’ which can be dynamically played using MIDI. 

In addition to the included sample library featuring sounds from renowned sound 
designers, S-LAYER comes bundled with an iPad Lemur MIDI template by Antonio Blanca 
as well as a MIDI template for Native Instruments’ Maschine.

*Reaktor Player is NOT Supported. 

2.1. How is it designed to work?
S-LAYER is a sampler that plays pre-recorded sounds or sounds that you load. It can be 
played via MIDI and/or by using your mouse. It runs inside of Reaktor in either plugin mode 
or standalone mode.  

Each time you play a note on your MIDI keyboard or hit the TRIG button, up to eight 
samples from the sample map will be played back simultaneously.  You can randomize or 
specify which samples play back and then edit each of the layers independently using 
sliders and toggle controls.

The parameters for each layer are laid out in a horizontal row as sliders and are grouped 
into cells by parameter type.  You can think of each row as a track or an independent 
sample layer with its own settings. You can make adjustments to the individual sliders or to 
the cell as a whole by using the range sliders below the cell or by using randomization and 
modulation. There are a total of four parameter pages that give you access to 25 controls 
for each layer.  

What is S-layer?
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2.2. S-LAYER Feature Highlights
Advanced layered sampler engine with granular capabilities and BPM stretching
Layered playback and editing of up to eight samples simultaneously
Intuitive and fast parameter cell interface
Independent sampler, filter, grain and fx send controls per layer
Extensive randomization options
4 assignable Modulation Sequencers with independent speed and length controls
4 assignable Wrapper knobs to offset cell slider positions and modulate live
8 Scenes per preset that store and recall parameter settings and modulation
Insert/FX Send system to connect and modulate your own effects
Transpose Mode to play layered sound combinations chromatically
Direct Outs per voice for Multi-Out Instrument support using DAWs or hardware 
effects
iPad Lemur MIDI template by Antonio Blanca
NI Maschine MIDI template by Twisted Tools
128 samples included in the default sample map

Sample content and sound design by:  Antonio Blanca, Richard Devine, Delect (Chris 
De Luca/Leonard De Leonard), EVAC, Glitchmachines, Mike Huckaby, Jedsound, Miguel 
Isaza,  pNORTNAOMI,  Surachai and Tonebuilder

What is S-layer?
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3. Getting Started with S-LAYER
The following sections will give you a very quick overview of how to get going with S-
LAYER. We will explain how to open S-LAYER and how to explore and use the default 
factory Snapshots (presets) and Scenes (sub-presets). Lastly, we’ll look at randomizing.

For more detailed information on working with Reaktor snapshots, please read the 
Application Reference manual that comes with your Reaktor application. 

If you are using Reaktor 5.7, be sure to turn on EDIT mode by clicking the structure icon 
next to the main snapshot menubar. Otherwise, you won’t be able to create snapshots and 
ad your own samples.

3.1. How to Open S-LAYER

To open S-LAYER:

1. Start Reaktor in standalone mode or plug-in mode. 

2. In Reaktor’s file browser (View > Show Browser), click on USER tab. 

If you didn’t install S-LAYER into your User Library, you can navigate to S-Layer.ens using 
the ‘Disks’ tab or simply drag and drop S-layer.ens onto the main Reaktor window from its 
location on the hard drive.

3. Double-click (or drag) S-LAYER.ens from the lower section of the browser onto the 
main Reaktor screen area and S-LAYER will be loaded and ready to play.

Getting Started
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If you are in standalone mode, you may need to go to File > Audio & MIDI Settings to setup 
your audio and MIDI. If you are in plug-in mode, be sure your track is armed and your audio 
driver is setup.

3.2. Exploring Snapshots and Scenes

Snapshots

A Snapshot is a preset. You can change a snapshot by using the snapshot drop down in 
the Main Bar . You can click the TRIG button near the top of the interface to trigger the 
default Snapshot.

Triggering and Playing Scenes

Each S-LAYER Snapshot has eight Scenes. You can think of the Scenes as sub-presets 
contained within each Snapshot that contain most of the controls. The Scenes can be 
played using MIDI or by selecting a Scene with your mouse and clicking the Scene TRIG 
button in the master section. 

To select and play a Scene with your mouse:

1. Select a Scene by clicking the number buttons with your mouse.

2. Click the master TRIG button to play a Scene.

To select and play a Scene with your keyboard:

1. Play notes C3 - G3 to select and play the Scenes on-the-fly.

2. Click the TRANSPOSE button to play the last selected Scene chromatically.

3. Click the Keyboard icon to return to using your MIDI keyboard to play and switch 
Scenes. 

In Reaktor standalone mode, you can use your QWERTY keyboard to simulate playing a 
MIDI keyboard.

Getting Started
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You can change the default root note for scene playback from c3 to any other octave, by 
dragging the value next to the keyboard icon. 

Randomizing Scenes

Clicking the Master RND button will randomize certain aspects of your Scene. Which 
aspects it randomizes depends on which areas are set to Master Random Active. 
Throughout the interface you’ll find small orange dots. These orange dots are Master 
Random Active toggles and determine whether that area is setup to receive randomization 
when using the Master RND button. 

You can toggle all areas on and off by clicking the orange Master Random Active Flip 
button in the master area shown below. 

To randomize various aspects of your Scene:

1. Select the ONESHOT Snapshot in the BASICS bank.

2. Click the Master RND button in the master section.

Notice how the sound changes. This is because the SAMPLE Cell has Master Random 
Active on, as indicated by the orange dot.

3. Next, click the Master Random Active toggle button located beneath the PITCH Cell.

4. Click the Master RND button at the top of the interface.

Notice how both the SAMPLE and PITCH cells are randomized when clicking the Master 
RND button. 

Getting Started

                                       S-LAYER USER GUIDE - PAGE 13



You can still use the individual Parameter Cell ‘Rnd’ buttons regardless of the Master 
Random Active state. 

3.2.1. Saving Snapshots using the Sidepane

As you work, you’ll make modifications and changes to the Snapshots. Naturally, you’ll 
want to save these. In order to save Snapshots,  you’ll need to be familiar with the Reaktor 
Sidepane area. If you are using Reaktor 5.7, be sure to turn on EDIT mode by clicking the 
structure icon next to the main snapshot menubar.

Getting Started
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Fig. 3.1 S-LAYER interface with Snapshot list in the Sidepane.

[1] Sidepane Button
[2] Snapshot drop-down menu
[3] Snapshot Banks 
[4] Snapshots area

First, let’s look at how to select snapshots using the Sidepane:

1. Be sure the Sidepane is open, by clicking the Sidepane Button (1).

2. Next, be sure to select ENS - S-LAYER from the Snapshot drop-down menu (2) if it 
isn’t already selected. 

3. Choose a bank of Snapshots that you’d like to listen to from the Snapshot Banks (3).

4. Choose presets from the Snapshots area (4) below.

The Snaphot drop-down menu you set in step two above, allows you to choose S-Layer’s 
Snapshots, or additional Snapshots for other instruments/effects you may be running inside 
of Reaktor alongside S-Layer.  For example, S-Layer comes with two additional effect 
instruments, Nanoverb and Delay. They both can have their own snapshot banks, though it 
isn’t necessary to create Snapshots for them since S-Layer will automatically store those 
settings when you save S-Layer snapshots.

Next, let’s look at the save options. 

At the bottom of the Snapshots area, you will see three buttons: APPEND, STORE and 
INSERT.  

APPEND: Creates a Snapshot in the next available free slot. 

STORE: Stores Snapshots by overwriting the current Snapshot.

INSERT: Inserts Snapshots in between other Snapshots, in a slot within any bank that you 
choose. 

Be sure you have ‘Ens - S-Layer’ selected in the Snapshot drop-down menu. We 
recommend turning ‘Linked’ off to avoid confusion.  Linked will automatically select the 
Snapshot drop-down menu to be set to the last instrument you clicked.

3.2.2. Copy and Paste Scenes Between Snapshots

You can easily copy a Scene to another Scene by clicking the COPY and PASTE buttons, 
but did you realize that it’s also possible to copy Scenes in between Snapshots? 

Getting Started
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For example, if you want to copy a sound from a specific Scene to another Scene in a 
different bank all you need to do is use Copy and Paste. 

To copy and paste a Scene from one Snapshot to another Snapshot:

1. Select a Snapshot and Scene to be copied. 

2. Click COPY.

3. Change to a new Snapshot or a new Bank

4. Select a Scene to use.

5. Hit PASTE. 

3.2.3. Snapshot Banks Described

There are plenty of Snapshots to help get you started with S-LAYER. Most Snapshots 
included eight Scenes as well, so don’t forget to check those out by switching Scenes as 
described above.  

S-LAYER’s Snapshot Banks are organized into the following categories:

BASICS - Default snapshots and basics to help learn about S-LAYER or start from 
scratch. 
ONESHOTS - Each Snapshot features a layered oneshot sound and Scene 
variations of that sound. There is one Snapshot for every sound in the map and 
they are ordered chromatically. In other words, Snapshot 1 uses Sample #1 as the 
basis for the sound combinations. Snapshot 2 uses Sample #2 and so on…
VARIOUS - A bank featuring different types of Snapshots. In this bank, you’ll find 
Drum kits laid out using Scenes, transposable instruments, loops, looped oneshots 
and anything that wasn’t a simple oneshot variation or basic Snapshot. 
ARTIST - This bank features Snapshots by different artists. We hope to add more 
here in the future.  
USER - We created this bank for your Snapshots. It is empty now, but hopefully it 
won’t be for too long! Go ahead, make some custom snaps - it’s easy! You can 
even copy/paste from our Snapshots to your own, using the Scene COPY and 
PASTE buttons.

Getting Started
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You can easily export and share your Snapshot banks. They don’t contain the included 
sounds and are just Snapshots (presets), so they’re quite small and easy to email.  We 
don’t mind you sharing Snapshots at all, just as long as you do not share the included 
sample library content. To export and save your Snapshots (without the samples), simply 
click the ‘Edit’ menu in the Snapshots Banks area.

3.3. Using your own samples
While the default sample map and presets should keep you busy for a long time, S-LAYER 
is a sampler that generates sound combinations using sample content. At some point, 
you’ll want to load up your own sounds and see what can be done. The more variety you 
put in, the more variety it will spit out. 

If you are using Reaktor 5.7, be sure to turn on EDIT mode by clicking the structure icon 
near the main menu bar before proceeding.

Opening the Sample Map Editor:

1. Right-click the wave folder icon located in the lower-left of the Wave Display.

2. Click Open Map Editor to open the Reaktor sample map editor.

The Sample Map Editor area will open which shows a list of all the samples. You can 
replace single sounds one at a time, add multiple sounds or replace the entire default 
sample map.

To replace a single sound:

1. Select the sound you’d like to replace.

2. Choose Edit > Replace from the Sample Map Editor.

3. When prompted, locate the sound you’d like to replace it with and click Open.

You can also drag from the file browser directly to the ‘Reaktor Sample Map Editor’. A red 
line will appear allowing you to insert the sample into the map at a specified position.

Getting Started
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To replace multiple sounds at once:

1. Click the ‘L’ header in the Sample Map Editor so that the samples are displayed 
chromatically starting at sample 0.

2. Shift-select a group sounds you’d like to replace.

3. Choose Edit > Delete from the Sample Map Editor.

4. Drag the replacement sounds to the Sample Map Editor until you see a red insertion 
line appear at the desired position.

To replace the entire sample map:

1. Shift-select all the samples in the map.

2. Choose Edit > Delete from the Sample Map Editor.

3. Drag up to 128 samples to the sample map area.

Sometimes samples have loop points written into the actual file and looping turned on. This 
will cause problems with most Twisted Tools Reaktor samplers. Make sure Loop is off. 

To save entire sample maps:

You may want to save your custom Reaktor map files to use later or to load in other 
Reaktor instruments. 

1. Choose Edit > Save from the Sample Map Editor. 

2. Save and name the document when prompted.

3. Click ‘Yes’ when asked to include the Audio Data in the Sample-Map.

A file appears on your desktop called YOUR_NAME.MAP which contains all the samples. 
You can use a .map Reaktor file in nearly any Reaktor sampler capable of loading multiple 
sounds.

To load your sample map into Reaktor:

Choose Edit > Load from the Sample Map Editor or drag and drop your map onto 
the editor or Folder icon in the Wave Display.

To create a sample map from a folder of samples:

Getting Started
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Download the Reaktor Sample Map Generator by Choronzon using the following 
link. 

http://relivethefuture.com/choronzon/2008/01/15/reaktor-sample-map-generator/

This handy application will allow you to instantly create sample maps based on folders of 
samples. 

Getting Started
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4. Overview of S-LAYER
In this section of the manual, we’ll examine the interface, look at basic signal flow 
principles and explain all the S-LAYER controls. 

There are two ways you can approach S-LAYER. You can hit random and drag sliders 
around until you hear something you like or you can spend time fine-tuning your sound 
combinations with precision. For starters, we recommend you begin exploring by looking 
at the Getting Started section to get familiar with Snapshots and Scenes.

4.1. The Interface

            Overview
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Fig. 4.1 S-LAYER User Interface.

[1] The Master area: Contains universal controls which are not stored with 
Scenes, but are stored with Snapshots.
[2] The Wave Display area: Contains a visualizer showing sample layer activity 
and a right-click area on the left to access the Sample Map Editor. 
[3] The Parameter area: Contains all the main parameters for the eight sample 
layers along with randomization and modulation destination controls.
[4] The Modulation area: Contains four Modulation Sequencers and four 
modulation Wrapper controls.
[5] The Scenes area: Contains Root note control for MIDI in, scene selectors, 
copy/paste and Transpose mode.
[6] The External effects: Contains the default External effects connect to S-
LAYER’s insert/send system. These effects can be easily switched out for your own 
effects.

4.2. The Signal Flow

Fig. 4.2 Overview of S-LAYER signal flow

All cyan colored text in Fig. 4.2 indicate controls/settings stored within a Scene, while 
Yellow text indicates controls that are globally stored with each Snapshot.

            Overview
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The signal flow diagram above flows from left to right, beginning with MIDI input and 
ending with the master Volume. MIDI in or clicking the TRIGGER button in S-LAYER’s 
Master area will trigger one of eight Scenes. 

A triggered Scene simultaneously plays up to eight sampler layers, which you can think of 
as independent parts. Each layer is stacked vertically and grouped by parameter into 
Parameter Cells. Sliders and toggles allow you to fine tune each layer’s parameters.

The Parameter Cells are laid out horizontally across four main pages.

            Overview
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Standard sampler parameters and additional effects/controls (Granulation, Filtering, 
Reversing and Looping) can be found within the MAIN, FX and ENV pages. The layers are 
combined and sent out for tuning (TUNE), before reaching the Master Decay (DEC) and 
VOL. stages. 

Each layer can also be can be split and sent independently to two effects, using the INS./
SEND Cell Sliders. Using these Sliders, each layer can be sent to one of two external 
effects, either as Inserts (INS.) or SENDS. By default, we’ve included two example effects 
(NANOVERB and DELAY) which are connected to INS./SENDS 1-2 respectively. You’ll 
also find modulation routing on the EXT. page which allows you to modulate your external 
effects. Read more about modulation in the Modulation section.

An insert effect’s output is mixed together with the combined layered sound before the 
master Decay stage. Additionally, an insert effect’s output is only passed if the current 
Scene has an amount slider set to a value greater than zero. This means that if you are 
using Inserts, switching to a Scene with no insert amounts above zero will instantly cut the 
output of the external insert effect. 

Using the sliders as SENDS the effects output signal flow changes slightly.  A send effect 
return gets mixed together with the combined layered sound post-master Decay and it’s 
output is never cut off by Scene changes, regardless of whether or not the new Scene has 
levels set above zero. 

Lastly, beneath each parameter cell, you’ll find Cell Range, Randomization and 
Modulation controls that allow you to further manipulate each Cell as a whole. More on 
that in the next section.

            Overview
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4.3. The Parameter Pages
In this section we’ll look at the common controls you’ll find throughout the interface and 
explain what each Parameter Cell does.

MIDI learnable Page switching is possible by assigning a CC to the Page Switcher, found 
within the instrument structure. In order to do this, you’ll need to free up a used CC though 
as we didn’t assign it by default and all CC’s are used already. See the advanced topics 
section in this guide for more info on custom MIDI assignments.

4.3.1. Working with Parameter Cells

The Parameter Cells and their additional controls, are the heart of S-LAYER. Most of your 
time in S-LAYER will be spent using these controls to change the various attributes of your 
sound. Let’s look at some examples to see what makes up a Parameter Cell.

Fig. 4.3.1 Parameter Cells

[1] Cell Label: Each cell parameter has a name that identifies it.  Most cell labels 
can be clicked to reset the sliders to their default state. 

The Strt | Delay cell label can be clicked to change the cell your viewing and working with, 
though they are entirely independent cells and controls. Right-click these labels to reset the 
cell.
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The Ins./Send Parameter Cell has a main label that works a bit differently. The label can be 
clicked to switch the behavior of the cell to be either an Insert or a Send. See the signal 
flow section above to get an idea of the difference between an insert and a send. Right-
click these labels to reset the cells.

[2] Cell Slider: Sets the value for the Cell Parameter for that layer. Cell sliders 1-8 
correspond to Layers 1-8 (top to bottom). 

Cell Slider mouse behaviors: Click and drag from left/right to adjust the values. Double-click 
to isolate the slider from being affected by randomization or modulation. The slider darkens 
to indicate it is isolated. Right-click to set to default and MIDI learn.

[3] Cell Range Slider: Sets the minimum and maximum values for the Cell sliders.
[4] Cell Randomizer: Randomizes the main cell. 

Cell Randomizer mouse behaviors: Clicking on the left side of the randomizer randomizes 
less than clicking towards the right side which randomizes more.

[5] Master Random Active Toggle: If on, clicking the Master RND button in the 
Master area will randomize this cell. If off, clicking the Rnd button in the Master area 
won’t randomize this cell. 
[6] Cell Modulation Selectors: The Cell Modulation Selectors allow you route any 
of S-LAYER’s four modulation sequencers (found in the Modulation area) to the cell.  
The modulation sequencer values are added to the cell values. 
[7] Cell Modulation Slide: Adds a ‘glide’ effect to the incoming modulation from 
arriving from Modulation Sequencers A, B, C or D. This smooths out incoming 
modulation by making the signal changes more gradual.
[8] Cell Modulation Spread: Increasingly offsets the modulation values for each 
layer by fanning the values out
[9] Mini-Cell Toggles: Certain cells have additional Mini-Cells to the left or right of 
the main cell area. These mini cells are on/off toggles or settings for each Layer. 

	
	 In the above example, the Reverse (REV) Mini-Cells are active for each each layer.

[10] Mini-Cell Label/Switcher: The Mini-Cell label identifies the function of the 
Mini-Cell Toggles. Some Mini-Cells allow you to switch between two sets of settings 
by clicking the Mini-Cell Label. 

	 The above example allows you to switch between adjusting Reverse settings and 
	 playback Speed settings for each layer.
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[11] Mini-Cell Master Random Active Toggle: If on, clicking the Master Rnd 
button in the Master area will randomize this Min-Cell cell. If off, clicking the Rnd 
button in the Master area won’t randomize this cell. 
[12] Quantize: The Pitch cell and the Start cell have a quantize icon. When on, the 
values are quantized. For Pitch this means semi-tones and for Start this means 
1/16th notes. 
[13] Cell Lock: The Cell lock button appears automatically when using BPM mode 
on Cells whose Slider settings might affect the timing of a layer. The Pitch, Start, 
Grain and Stretch cells each have a Cell Lock button which will temporarily bypass 
the cell’s problematic sliders. Bypassed sliders are dark colored and clicking them 
results in a flashing BPM button to indicate that the Cell Slider is locked. You can 
manually click the Cell Lock to toggle it off if desired, but this may result in layers 
timing to not be synced to the BPM.   See the Understanding BPM Mode section 
of this guide for more information on working with BPM mode.

4.3.2. The Parameter Cells and Pages Defined

There are four main Parameter Pages with Parameter Cells and controls. In this section we 
will define each page and its controls. 

Right-click the Parameter Page labels to reset the entire page’s Parameter Cells to their 
default.

The MAIN Page  - The main sampler engine parameters

REV: Reverses playback.

SPEED: Adjusts the playback speed when BPM mode is on. 

1x = Original Speed
2x = Half-speed
/2 = Double-speed

PHASE: Inverts the phase (polarity) of the signal.

SAMPLE: Determines which of the 128 samples to playback.

STRT | DLY: Adjusts the sample playback start position when STRT is selected and 
adjusts the start delay time when DLY is selected (up to 1000ms). Keep in mind that these 
are two completely independent cells with independent controls. Right-click these cell 
labels to reset these cells.
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The Delay time can be easily adjusted at the root level of the ensemble structure and 
changing the value for the constant called DLY ms in the Function tab of the objects 
properties.  

PITCH: Adjusts the sample playback pitch. 

PAN: Adjusts the left/right pan position. 

VOLUME: Adjusts the volume. 

SOLO: Solos layer (solo is only active if solo Label Switcher is selected) and layer will be 
highlighted.

MUTE: Mutes layer.

MONO: Sums layer to mono.

The FX Page - The sampler FX parameters

GRAIN ON: Turns ON the granular sampler engine.

GRAIN: Sets the grain size for the granular sampler engine.

STRETCH: Sets the speed of the grain playback.

CUTOFF: Sets the cutoff frequency. 

RESONANCE: Sets the filter resonance amount.

FILTER MODE: Crossfade for the filter type. 

Left position = Lowpass
Middle Position = OFF
Right Position = Highpass

The ENV Page - The envelope parameters

LOOP: Turns on looping for the selected layer so that the sound repeats as long as the 
Scene is being triggered.

ATTACK: Time it takes for volume to reach maximum amplitude once sound is triggered.

HOLD: Time the sound sustains after attack, before the decay stage begins.
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DECAY: Time it takes for sound to reach the sustain level.

SUSTAIN: Volume at which the sound sustains while you hold a note or while a gate 
message is present.

RELEASE: Time it takes for the sound to return to zero (off) once a note has been 
released or the Trig message ends.

The EXT Page - The external FX and modulation matrix parameters

INS./SEND 01: Amount sliders that route layers to either the insert or send path that 
connects to external effect 01 (Nanoverb by default - can be changed to your own effect). 
Clicking the Label/Switcher changes Cell behavior from inserts to sends. Inserts effect 
returns are mixed together with the combined layer sound pre-decay, whereas sends are 
mixed together with the combined layered sound post-decay and pre-volume. Additionally, 
when using inserts, the effect is only returned when a scene has at least one slider set to a 
value greater than 0, whereas Sends will always pass the effect returns, regardless of a 
given scenes slider values.

INS./SEND 02: Amount sliders that route signal to either the insert or send path that 
connects to external effect 02 (Delay by default - can be changed to your own effect). 
Clicking the Label/Switcher changes Cell behavior from inserts to sends. Inserts effect 
returns are mixed together with the combined layer sound pre-decay, whereas sends are 
mixed together with the combined layered sound post-decay and pre-volume. Additionally, 
when using inserts, the effect is only returned when a scene has at least one slider set to a 
value greater than 0, whereas Sends will always pass the effect returns, regardless of a 
given scenes slider values.

EXTERNAL MODULATION MATRX: The external modulation matrix allows you to use S-
LAYER’s Modulation Sequencers to send data to other Reaktor instruments/effects or any 
device capable of receiving MIDI. For details on using the External Modulation Matrix, see 
the section below entitled Modulation. 

STEREO/MULTI-OUT SWITCHER: Changes the output behavior from Stereo to Multi-
Out. When in Multi-Out mode, layers are routed directly to Reaktor’s independent outputs 
without being summed. This way you can process each layer independently using a multi-
out capable DAW or hardware interface. For more info how to connect and use the multi-
outs, see the section entitled Connecting your own effects.
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5. Working with Modulation
S-LAYER has four Modulation SEQUENCERS and four WRAPPER Knobs which can be 
routed to the Parameter Cells in order to modulate the Parameter Cell controls in realtime.

5.1. The Modulation Sequencers
S-LAYER has four Modulation Sequencers, labelled A, B, C and D. They are located in the 
Modulation area and can be accessed by clicking the button label that says 
SEQUENCERS.

You can think of the Modulation Sequencers as automation patterns that can be used in a 
way that is similar to traditional LFOs and Envelopes. The Modulation Sequencers can 
create patterns that repeats (like to an LFO) or patterns that stop and hold the last value 
(like an Envelope).  

The Modulation Sequencers can be routed to any of the parameter cells (and combined 
together by selecting more than one) by using the Cell Modulation Selectors described 
above. 

Don’t forget that you can isolate Parameter Cell Sliders from being affected modulation by 
double-clicking them.

All the controls are independent for each Modulation Sequencer’s A, B, C and D.  Simply 
drag and draw information in the modulation sequencer or use some of the modulation 
settings to create and manipulate patterns. Control-click and drag to lock the Y axis in 
place as you draw.
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Fig. 5.1 Modulation Sequencer

[1] Modulation Page Label/Switcher: Identifies the function of the currently 
selected modulation type, Sequencer or Wrappers. 
[2] Modulation Selector: Identifies which of the four Modulation Sequencers you 
are viewing and editing. 
[3] Edit Functions: Copy, Paste and Reverse a selection or the entire pattern.  A 
selection can be made by using the Modulation Sequencer Cycle Area (11) 
control. 
[4] Master Random Active Toggle: If on, clicking the Master Rnd button in the 
Master area will randomize this Modulation Sequencer. If off, clicking the Rnd 
button in the Master area won’t randomize this Modulation Sequencer. 
[5] Waveform Patterns: These buttons will auto insert a waveform shape into the 
currently selected area. The patterns are Soft Random, Random, Sine, Square, 
Triangle and Sawtooth.  You can use the Reverse Edit button to flip your pattern.
[6] Waveform Bend: Bends and rolls the shape of the waveform to create unique 
wave shapes.
[7] Smooth: Turns On smoothing between each step. If OFF, you will here value 
changes instantly. If On, changes between values will be smooth. Use off for 
‘sample and hold’ type effects.
[8] Speed: The Modulation Sequencer’s playback speed. Drag to change. 
[9] Loop Mode: Turns on modulation pattern cycling, so that the pattern repeats 
so long as an incoming note is held down. If OFF (grey), the pattern will playback 
until a note or trigger is released at which point the last value will hold.
[10] Power: Turns the current modulation pattern ON or OFF.
[11] Cycle Area: Sets the length and playback range of the modulation sequencer. 

5.1.1. The External Modulation Matrix

S-LAYER’s Modulation Sequencers can be sent out of S-LAYER to other Reaktor 
instruments/effects or hardware synths and DAWs using MIDI.  

The EXTERNAL MODULATION MATRIX is used to make routing assignments and is 
found in the EXT Parameter Page.
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Fig. 5.1.1 Ext. Modulation Matrix

[1] Modulation Source Menu: Selects the Modulation Sequencer source for the 
routing destination assignment made below it. 
[2] Modulation Destination Menu: Selects the type of signal that you’d like to be 
sent from the Modulation Sequencer selected above it. 

	
	 Modulation Destination types:
	 IC SENDS: Used to route signal internally to Reaktor Instrument parameters. 
	 MIDI CC: Used to route out a standard MIDI CC event.
	 MIDI NOTE: Used to route out MIDI notes.

[3] Assignment Menu: Assign IC Send destinations for or a MIDI value.
[4] Modulation Output Range: Adjusts the Min./Max range of the external 
modulation signal.

5.2. The Wrapper Knobs
S-LAYER has four WRAPPER Knobs that offset the slider positions of an entire Parameter 
Cell.  They’re called Wrappers because the offset is relative to the position of the Cell 
Parameter Sliders. In most cases, this means that the Sliders will wrap around and start 
over at zero as you twist the Wrapper Knob.  

Any Wrapper Knob can be assigned to any of the Parameter Cells by using a simple drop-
down menu and the assignment is stored with the Snapshot. Only one assignment per 
Wrapper is possible. 

Don’t forget that you can isolate Parameter Cell Sliders from being affected by modulation 
by double-clicking them.
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Fig. 5.2 Wrapper Knobs

[1] Modulation Page Label/Switcher: Identifies the function of the currently 
selected modulation type, Sequencer or Wrappers. 
[2] Wrapper Knob: The Wrapper Knob offsets the assigned Parameter Cell values 
by adding the Knob value you to the current Parameter Cell values.
[3] Wrapper Assignment Menu: Assigns a Wrapper to a Parameter Cell.  Click 
the page buttons at the top of the menu to switch assignment pages. 

If you’d like to close the wrapper menu without changing and entry, you can right-click on 
the dropdown menu.
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6. Working with Scenes
Each S-LAYER Snapshot has eight Scenes. You can think of the Scenes as sub-presets 
contained within each Snapshot. A Scene contains all the the Parameter Page settings 
and controls as well as the Modulation Sequencer controls.  

The Wrapper Knobs are NOT included with Scene recall. They are stored with the 
snapshot. 

Scenes can be played using MIDI or by selecting a Scene with your mouse and clicking 
the Scene TRIG button in the master section. 

In Reaktor standalone mode, you can use your QWERTY keyboard to simulate playing a 
MIDI keyboard.

Fig. 6.0 Scenes

[1] Scene MIDI: When active, MIDI input will trigger the Scenes by playing 
chromatically, starting at note C3. The root note can be adjusted by octave, 
dragging the value. 

When Transpose is active, MIDI in will Transpose (5) the current Scene and will not switch 
scenes. 

[2] Scene Root: Sets the root note (by octave) for MIDI playback of the Scenes. By 
default c3-g3 will playback scenes 1-8. 
[3] Scene Copy: Copies the entire Scene (Parameter Page settings and 
Modulation Sequencers)
[4] Scene Selectors: Selects a Scene to playback.
[5] Scene Paste: Pastes the last copied Scene into the currently selected Scene.
[6] Scene Transpose: Transposes the current Scene so that you can play it 
chromatically. When Scene transpose it active, the Scene MIDI function is 
temporarily disabled. 
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You can still use your Mouse to select Scenes when in Transpose 

[7] Safe Scene Switching Mode: When ON, Safe Scene Switching (Lightening 
Bolt icon) will reduce the load increase when Scene Switching in DAWs. If you’re 
trying to play back Scenes and are hearing clicks, try turning this on. With this 
button ON, the load should improved and clicks should disappear. We recommend 
that you always leave this OFF, unless you are experiencing problems that standard 
remedies outlined in the troubleshooting section don’t fix. Either way, regardless of 
whether or not you use this mode, when bouncing your audio, any clicks and pops 
due to heavy Scene switching will not appear in the resulting bounce. Please see 
the troubleshooting section for more info on how to optimize S-Layer.

When using Safe Scene Switching mode, a latency of 11ms will be applied upon Scene 
switching. In most cases this will be inaudible, though you should disable CPU Safe mode 
when bouncing if you want the bounced audio to be sample accurate. Alternatively, you 
can adjust your audio after you bounce by 11ms.

Should you want to increase the value for Safe Scene Switching mode to make S-LAYER 
even more optimized in heavier sessions, you can adjust the value by setting the properties 
for the Safe Mode constant found in the top level of the S-LAYER structure.

6.1. The Master Area
The Master Area Contains universal controls which are not stored with the individual 
Scenes, but are stored with Snapshots.  

Fig. 6.1 Master Area

[1] BPM:  When BPM mode is active, the layers will stretch to fit the current BPM 
by using either Pitch or Grain stretching methods. Different layers can be set to 
different stretching methods. 
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You can use the Speed Mini-Cells to correct tempo calculation factoring errors. For 
example if a sample is detected as being 80bpm when in fact it is 160bpm, you can adjust 
for that using the /2 factor.

[2] Glide:  When GLIDE is active, playing MIDI notes on your keyboard will create a 
portamento or pitch gliding effect. You will hear this effect when playing two Scenes 
with different Pitch Parameter Cell settings or when playing a Scene using different 
notes in Transpose mode.
[3] Velocity:  When VEL is active, playing MIDI notes at different velocity affect the 
output volume of your layered sound (pre-master Volume). 
[4] Rnd:  When the Master RND button is triggered, the current Scene is 
Randomized. Clicking the Master Rnd button will only randomize certain aspects of 
your Scene. Which aspects it randomizes depends on which areas are set to 
Master Random Active. Throughout the interface you’ll find small orange dots. 
These orange dots are Master Random Active toggles and determine whether that 
area is setup to receive randomization when using the Master Rnd button.
[5] Auto Randomize Scene:  Activating this toggle will turn on Auto Randomize 
Scene and the toggle will turn blue. When Auto Randomize Scene is on, playing a 
Scene using MIDI notes will automatically randomize that Scene.  This way you can 
always randomize and trigger a Scene when playing it. When you find a sounds you 
like and want to keep, you can turn Auto Randomize Scene off. 
[6] Trigger Scene:  Pressing TRIG will trigger the current Scene which will 
playback for as long as you hold the button down.

You may trigger and hold a Scene, but find that the sound cuts off early. This may be 
because of the ENV page Parameter Cell control settings for AHDSR. If you have layers 
that end before the Scene Trigger is released, you may think something isn’t working. Be 
sure to check your AHDSR settings.

[7] Random Active Flip: Flips all the Master Random Active toggles on or off 
when clicked.
[8] Tune: Controls the overall tuning (pitch) for the current snapshot.
[9] Decay: Controls the overall decay envelope (decay) for the snapshot, effectively 
shortening the length of all Scenes by applying a gradual decrease in volume each 
time you Trigger a Scene.
[10] Auto: Auto volume control that prevents clipping. When you turn on AUTO, 
depending on the number of active voices, the volume will decrease to prevent 
clipping. For example, if only two voices are active, each voice will be dropped 
approximately 3db. Use this feature if you would like to be sure that your layered 
sound never clips.  
[11] Vol: Master volume control determines the final output level of your layered 
sound and effects. 
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[11] Master Limiter: Limits the volume output to prevent clipping by reducing 
signals over 0dB. Use the Volume knob to increase input into the Limiter to achieve 
more extreme limiting effects. 

If you’d like to turn the Limiter off or on for all presets, you can set it to Snap Isolate.  To do 
so, simply right-click the Limiter icon (while in Edit mode in Reaktor 5.7), choose 
‘Properties’ and check the Snap Isolate checkbox in the Functions tab in the Sidepane. 
Save S-Layer and now the Limiter setting is not stored with your Snapshots. 

7. Advanced Topics
In this section we’ll look at some more advanced topics, such as BPM mode, working with 
external effects and using Reaktor’s built-in recording functions.

7.1. Understanding BPM Mode
When BPM mode is active, the layers will stretch to fit the current BPM by using either 
Pitch or Grain stretching methods. Different layers can be set to different stretching 
methods. 

Depending on the method you choose, different Parameter Cell sliders will become locked 
as described below. In either case the Start Parameter Cell will be locked by default. The 
Start Parameter Cell will be locked by default to ensure that the Start time is set to zero for 
your samples. This ensures BPM synchronization. This can be undone by clicking the Lock 
icon.  Furthermore, you can quantize the Start time by clicking the Note icon next to the 
Start Cell.

Pitch Stretching: 
When Grain Mode is OFF for a given layer, the sample will stretch to fit the current BPM by 
automatically changing their pitch. 

When using BPM Pitch Stretching, a Lock icon appear next to the Pitch Cell, indicating 
that you have at least one layer that is set to Pitch Stretching. Layers that are locked are 
indicated by a dark horizontal Cell Slider that can’t be dragged. If you attempt to drag a 
locked Slider, the BPM button will Blink to indicate that the Cell Slider is locked. You can 
‘unlock’ a Parameter Cell by clicking the lock button, but then the automatic BPM 
adjustments will be offset by any change you make. This may result in something 
interesting, though it is not recommended if your’e after tight synchronization.

Grain Stretching: 
When Grain Mode is ON for a given layer, the sample will stretch to fit the current BPM by 
using granular stretching while preserving the pitch of the original sample.
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When using BPM Grain Stretching, a Lock icon appear next to the Grain and Stretch Cells, 
indicating that you have at least one layer that is set to Grain Stretching. Layers that are 
locked are indicated by a dark horizontal Cell Slider that can’t be dragged. If you attempt 
to drag a locked Slider, the BPM button will Blink to indicate that the Cell Slider is locked. 
You can ‘unlock’ a Parameter Cell by clicking the lock button, but then the automatic BPM 
adjustments will be offset by any change you make. This may result in something 
interesting, though it is not recommended if you’re after tight synchronization.

7.2. Using External Effects (FX 1/FX 2)
S-LAYER comes with two external effects connected to SLAYER’s INS./SENDS system 
found on the EXT page. By external effects, we mean to say that the effects are not a part 
of the S-LAYER structure itself and can be easily replaced.  You can add your own Reaktor 
effects or choose from hundreds of the excellent effects available in Reaktor’s User library.  

Connecting up your own effects to the INS./SENDS is a simple matter of jumping into S-
LAYER’s structure and replacing FX 1 and FX 2.

7.2.1. Adding Reaktor Ins./Send effects:

1. Right-click the S-LAYER label and choose Show Ensemble Structure.

2. Select either the NANOVERB and/or DELAY.

3. Hit delete to erase them.

4. Right-click the background of the Reaktor structure and choose an effect. 
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5. Connect up the FX 1L-R outputs to the L-R inputs of your effect and then connect the 
L-R outputs of your effect to S-LAYER’s FX 1L-R inputs.

6. Use the INS./SENDS on the EXT page to control which layers to send to that effect.
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7.2.2. Connecting the Send system to your DAW’s effects:

You may want to setup S-LAYER Ins./Send system with your DAW’s effects. The process 
is similar to the process of connecting Reaktor effects, except you will need to use a multi-
out instance of Reaktor in your host software in order to route the FX sends to your DAW’s 
effects. Check with your host DAW’s documentation to see if it supports Multi Output 
software instruments. If it does, use the 8 x Stereo output instance.

1. In your host software, create a 8 x Stereo multi-out instance of Reaktor.

2. In your host, create auxes or audio channels to receive outputs 3-4 and 5-6 from 
Reaktor.

3. In Reaktor, open the structure and cable the FX L-R outputs to outputs 3-4 and 5-6. 

4. Use the INS./SEND Parameter Cells on the EXT page to send signal to the effects.

Using the above method will always result in Send behavior. Using the master Decay will 
have no affect and the effect return will always be on, regardless of the current Scene’s 
slider settings.  If you’d like to achieve S-LAYER’s Insert behavior with your own effects, 
you’ll need to sum the effects in your DAW and return them both into FX 1 L-R and set FX 
1 to .Ins

7.2.3. Using S-LAYER’s Multi-Outs

You may want to setup S-LAYER with your DAW or hardware effects so you can process 
each layer independently. To process S-LAYER layers independently directly in your DAW, 
you’ll need to setup a Multi-Out instance of Reaktor in a DAW that supports up to eight 
stereo software instrument outputs (Ableton Live or Logic Pro). You’ll then need to turn on 
MULTI-OUT in the EXT page.

Only the AU version of Reaktor supports all 8 outputs. VST instances will only support 3 
stereo outputs.

To process S-LAYER layers independently using hardware, you’ll need an audio interface 
that supports 8 stereo outputs.   
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Lastly, if you don’t have a Multi-Out capable host or simply prefer to use Reaktor in 
standalone mode, you can route signal between applications using something like 
Soundflower by Cycling74 for the Mac or JackAudio for Windows.

http://cycling74.com/soundflower-landing-page/

http://jackaudio.org/download

S-LAYER Multi-Out Signal Routing

Layer 1 - Outputs 1-2
Layer 2 - Outputs 3-4 
Layer 3 - Outputs 5-6
Layer 4 - Outputs 7-8
Layer 5 - Outputs 9-10
Layer 6 - Outputs 11-12
Layer 7 - Outputs 13-14
Layer 8 - Outputs 15-16

To use S-LAYER’s Multi-Outs with your host:

1. Open S-LAYER’s EXT parameter page.

2. Click the Label/Switcher that says ‘Multi-Out’.

3. In your host software, create a 8 x Stereo multi-out instance of Reaktor.

4. In your host, create auxes or audio channels to receive outputs 3-4 through 15-16 from 
Reaktor.
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To use S-LAYER’s Multi-Outs with your hardware:

1. Open Reaktor in standalone mode or in your DAW as an 8 x Stereo multi-out 
instrument.

2. Click on S-LAYER’s EXT parameter page.

3. Click the Label/Switcher that says ‘Multi-Out’.

S-LAYER’s layers will now be routed to outputs 1-16.

4. If you’re using a DAW, create auxes or eight stereo audio channels to receive outputs 
1-16 from Reaktor and route their outputs to your desired to the desired hardware 
effects.

To use S-LAYER’s Multi-Outs with Soundflower:

1. Open Reaktor in Standalone mode.

2. Open S-LAYER’s EXT parameter page.

3. Click the Label/Switcher that says ‘Multi-Out’.

S-LAYER’s layers will now be routed to outputs 1-16.

4. Go to Reaktor’s File > Audio & MIDI Settings and choose Soundflower 16 Channels 
from the main device.

5. Go to your host software and setup Soundflower or JackAudio as the input device.

6. Setup Audio channels in your host to record inputs 1-16 as stereo pairs.

This video by Jedsound shows how to setup S-LAYER using Soundflower and Pro Tools:  
http://www.youtube.com/watch?v=ser6VDg2iYQ

7.3. Using Reaktor’s Recorder 
While S-LAYER can be played live inside a host, it is more CPU efficient and often times 
more practical to simply create sounds in S-LAYER and record them as audio to use in 
your host.

Reaktor has an amazing built-in tape recorder that allows you to instantly create recordings 
of your sounds and drag & drop audio them from Reaktor directly to other hosts such as 
Ableton or Maschine. You can even drag & drop audio from Reaktor while it is running in 
plug-in mode!

We highly recommend that you check this out, as it is a great way to make kits.
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To record S-LAYER sounds as audio and drag and drop them into your host:

1. Open up S-LAYER and find a sound you like.

2. From within Reaktor, File>View > Show Player and Recorder.

3. Click where it says ‘Untitled Audiofile’ and name it something relevant (S-Layer 01).

4. Click the Settings icon on the far right and choose ‘Record Start by: Note ON’

You can also chose ‘Record stop by note off’ which will automatically stop recording when 
you release your note, though if you have a sound with a long release time this may not be 
the best method.

5. Click OK. 

6. Hit the record button on the Recorder. 

7. When you’re ready to begin recording your sound, play and hold your note.

8. Click the Stop button on the Recorder to end your recording. 

9. Drag the Audio file to your host by using the drag icon.

10.Rinse and repeat.  
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8. MIDI Templates
S-LAYER comes with a MIDI template for Native Instruments Maschine and a MIDI 
template for iPad’s Lemur designed by Lemur expert Antonio Blanca. Additional 
documentation on how to use these templates can be found in the Template 
Documentation folder within the Documentation folder.

In order to use the MIDI template for Maschine, you will need Native Instruments 
‘Maschine’.

http://www.native-instruments.com/#/en/products/producer/maschine/

To use the MIDI template for Lemur, you’ll need to get the Lemur application for your iPad 
and the Lemur editor for your Mac or PC.

http://liine.net/en/

http://liine.net/en/support/lemur

8.1. Understanding the MIDI Mapping
S-LAYER has several hundred controls. Unfortunately, we couldn’t map all of them due to 
restrictions with Reaktor and MIDI. However, we did make every effort to map as many 
controls as possible by creating a special multi-destination MIDI ‘layer’ to control more 
than 128 controls. By using switches to address common controls, you can control almost 
all of S-LAYER’s controls using a MIDI controller.

For example, to control the five Main Parameter Cells, we only used eight sliders. A MIDI 
‘Destination’ toggle was setup to choose which of the five main parameter cells you’re 
controlling at any given moment with those eight sliders.

The Lemur template and the Maschine template both take advantage of this system. If 
you’d like to setup your own MIDI template to control S-LAYER, the MIDI 
Implementation Chart section features a MIDI chart of all the MIDI CC assignments.

8.2. Making your own MIDI Assignments Using MIDI Learn
As mentioned above, S-LAYER is pre-mapped. There are no free CC’s available to MIDI 
Learn which means that if you want to make custom assignments, you’ll need to delete 
some of the assignments we made. 
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Some parameters like the Sliders in S-LAYER can be right-clicked to activate MIDI learn. If 
you right-click a slider and MIDI learn it to a controller on your MIDI controller, it will 
deactivate other instances of this MIDI CC within the ensemble. This makes setting up 
custom assignments easy

This kind of assignment will be saved with the Reaktor ensemble, so save a backup in case 
you’d like to revert to the original!

8.2.1. Assigning MIDI CC’s to GUI Display Switchers
Some parameters like the Page Switchers can’t be right-clicked to MIDI learn and aren’t 
already assigned. You will need to assign them, but will have to remove another 
assignment in order to do so.

To assign MIDI CC’s to the Main Page Switchers (MAIN, FX, ENV, EXT):

1. Check the MIDI chart at the end of this manual to see the current assignments to 
determine which you’d like to remove. 

2. Setup your keyboard/controller knob to output the CC# you choose to use.

3. In Edit Mode (Reaktor 5.7), double-click the background of the S-Layer panel to jump 
to the top level structure.

4. Find the Knob called PAGE CNTRL.

5. Right-click the knob and choose MIDI learn

6. Move a controller on your Keyboard/Controller.

To assign MIDI CC’s to the Sequencer/Wrapper Switchers:

1. Check the MIDI chart at the end of this manual to see the current assignments to 
determine which you’d like to remove. 

2. Setup your keyboard/controller knob to output the CC# you choose to use.

3. In Edit Mode (Reaktor 5.7), double-click the background of the S-Layer panel to jump 
to the top level structure.

4. Find the Button called MOD.PAGE CNTRL.

5. Right-click the knob and choose MIDI learn

6. Move a controller on your Keyboard/Controller.
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To assign MIDI CC’s to the STRT | DLY Cell Switchers:

1. Check the MIDI chart at the end of this manual to see the current assignments to 
determine which you’d like to remove. 

2. Setup your keyboard/controller knob to output the CC# you choose to use.

3. In Edit Mode (Reaktor 5.7), double-click the background of the S-Layer panel to jump 
to the top level structure.

4. Find the Button called START CNTRL.

5. Right-click the knob and choose MIDI learn

6. Move a controller on your Keyboard/Controller.
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9. Troubleshooting and FAQ
Sometimes you might run into trouble when using S-LAYER. In this section we’ll go over 
some of the common issues you might encounter and how to resolve them.

Can I use the Reaktor Player with S-LAYER

No, S-LAYER requires the full version of Reaktor 5.62 and won’t run with Reaktor 
Player. 

Can I use my own samples?

Of course you can. Just right-click the folder icon on the wave display and open the 
sample map editor. Check out the Using your own samples section of this guide 
for more information. 

Why can’t I add my own samples and click the folder to edit my map?

In Reaktor 5.7, you’ll need to turn on Edit mode in order to edit ensembles like S-
LAYER. Click the structure icon next to the main snapshot menu to turn on Edit 
mode.

I can’t hear anything.

Is your track record enabled (plug-in mode only)? 
Is Reaktor setup as an instrument (plug-in mode only)? 
Have you setup your Audio & MIDI Settings under File>Audio & MIDI Settings 
(standalone mode only)?
Are you sending MIDI note C3-G3 to trigger scenes?
Have you turned the Volume knob down by accident?
Have you accidentally randomized the Volume cell or your Envelope Cells?

The scene buttons aren’t working.

Is the Transpose mode on? If so, MIDI note input will transpose your sound but not 
change your Scene.

I’m hearing lots of clicks when playing Scenes.

S-Layer has hundreds of controls and changing Scenes can be heavy on some 
computer CPU’s. Often times you’ll hear pops and clicks when changing Scenes on 
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some machines. To fix this, click the ‘Lightening Bolt’ icon to turn on Safe Scene 
Switching mode. Doing so will result in latency (11ms), but when you’re ready to 
bounce your project just turn it off or adjust your audio back by 11ms after your 
bounce. You can customize the Safe Scene Switching Mode amount by changing 
the value at the top level of S-LAYER’s structure, called SAFE MODE by editing its 
properties. 
You should also set your Audio driver buffer size higher. Usually a setting of 512 or 
1024 will immediately solve the problem, but will introduce latency.  Either way, if 
you bounce offline, you should notice that the clicks and pops disappear. 
Some hosts have a ‘Processor Buffer’ setting, which is different from your Audio 
Driver buffer. If your host has this setting, be sure to set this to ‘Large’ (Logic 
Pro>Preferences>Audio>Processor Buffer) or ‘Same as Audio 
Driver’ (Ableton>Preferences>CPU>Plugin Buffer)
If using Logic Pro, select another track when you’re not using S-Layer or when you 
want to reduce CPU load that may be causing clicks. By selecting another track, 
Logic goes out of ‘Live Mode’ and S-Layer CPU will be much improved when 
Scene switching.
S-Layer is monophonic and when you play a new Scene, it interrupts the last 
Scene. Sometimes this results in clicks if you have sounds with long releases. One 
method you can use to eliminate clicks  sometimes can be to make sure you have 
no overlapping notes or adjust the release time. 

Can I adjust the Delay Cell length to be longer? 

Yes! In Edit mode, just jump into the top level of S-Layer’s structure and adjust the 
DLY module’s value in its properties, found in the function tab.  

Things sound different compared to an earlier version of S-Layer I was using, 

why?

We’ve improved the sound quality of S-Layer starting with version 1.1. The 
transients will be much cleaner/crisper. We also added a Master Limiter to tame the 
new transient behavior and prevent clipping. This will change how previous versions 
of S-Layer sounded. The Limiter setting is stored with the Snapshot, though you 
can Snap Isolate it if you like.  We recommend that you use the older S-Layer 
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version on projects you are still finishing, where consistency with sounds you 
created earlier is important.

All my loops are playing at the wrong speed in BPM mode.

Sometimes the BPM detection interprets slow loops or fast loops incorrectly as 
being half-speed or double speed. If this is the case, click the SPEED Mini-Cell to 
the left of the main Sample cell and adjust the speed factor for the layer that is 
playing at the wrong speed. 

No matter what, all I hear is one layer.

Is SOLO mode on? Click on the Label/Switcher to switch back to MUTE mode 
which will turn off Solo mode. 

I’m trying to adjust a slider in a cell, but it won’t let me!

Are you in BPM mode? If so, certain sliders will be ‘locked’ in order to keep things 
in sync with the BPM. Please see the BPM Mode section in this guide for a full 
explanation. 

Why can’t I send IC SENDS back to S-Layer? I don’t see them in the menu!
Due to some changes in Reaktor having to do with snapshot management, we’ve 
lost the ability to see [SELF] parameters in the IC SEND drop down menus. We 
hope that this will be fixed by NI with an updated, but in the meantime, if you’d like 
to send IC SEND messages to S-Layer parameters, use the Connect tab in the 
properties. See your Reaktor manual for more info.
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10. MIDI Implementation Chart
CC # PARAMETER ASSIGNMENTS NOTES

Pitch Bend Pitch Bend Module -12 to +12 (User Adjustable)
0 Master Rnd x
1 Master Tune x
2 Master Decay x
3 Master Amp x
4 BPM x
5 Trig x
6 Scene1 x
7 < Reserved > < Reserved > Hosts use this for Volume.
8 Scene2 x
9 Scene 3 x
10 < Reserved > < Reserved > Hosts use this for Pan.
11 Scene 4 x
12 Scene 5 x
13 Scene 6 x
14 Scene 7 x
15 Scene 8 x
16 SceneCopy x
17 ScenePaste x
18 SceneMode x
19 Transpose Mode x
20 WRAPPER1 x
21 WRAPPER2 x
22 WRAPPER3 x
23 WRAPPER4 x
24 Wrapper1 Dest x
25 Wrapper2 Dest x
26 Wrapper3 Dest x
27 Wrapper4 Dest x
28 rev1 x
29 rev2 x
30 rev3 x
31 rev4 x
32 rev5 x
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33 rev6 x
34 rev7 x
35 rev8 x
36 mute1 x
37 mute2 x
38 mute3 x
39 mute4 x
40 mute5 x
41 mute6 x
42 mute7 x
43 mute8 x
44 Main Dest x Routes sliders to parameter cells
45 Main Slider1 x
46 Main Slider2 x
47 Main Slider3 x
48 Main Slider4 x
49 Main Slider5 x
50 Main Slider6 x
51 Main Slider7 x
52 Main Slider8 x
53 Main Range Lower x
54 Main Range Upper x
55 Main Rnd < Not Used > Lemur
56 Main RndIso x
57 Main A x
58 Main B x
59 Main C x
60 Main D x
61 Main Spread x
62 Main Slide x
63 FX Dest x Routes sliders to parameter cells
64 FX Slider1 x
65 FX Slider2 x
66 FX Slider3 x
67 FX Slider4 x
68 FX Slider5 x
69 FX Slider6 x

            MIDI Implementation Chart

                                       S-LAYER USER GUIDE - PAGE 50



70 FX Slider7 x
71 FX Slider8 x
72 FX Range Lower x
73 FX Range Upper x
74 FX Rnd < Not Used > Lemur
75 FX RndIso x
76 FX A x
77 FX B x
78 FX C x
79 FX D x
80 FX Spread x
81 FX Slide x
82 Env Dest x Routes sliders to parameter cells
83 Env Slider1 x
84 Env Slider2 x
85 Env Slider3 x
86 Env Slider4 x
87 Env Slider5 x
88 Env Slider6 x
89 Env Slider7 x
90 Env Slider8 x
91 Env Range Lower x
92 Env Range Upper x
93 Env Rnd < Not Used > Lemur
94 Env RndIso
95 EXT Dest x Routes sliders to parameter cells
96 EXT Slider1 x
97 EXT Slider2 x
98 EXT Slider3 x
99 EXT Slider4 x
100 EXT Slider5 x
101 EXT Slider6 x
102 EXT Slider7 x
103 EXT Slider8 x
104 EXT Range Lower x
105 EXT Range Upper x
106 EXT Rnd < Not Used > Lemur
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107 EXT RndIso x
108 EXT A x
109 EXT B x
110 EXT C x
111 EXT D x
112 EXT Spread x
113 EXT Slide x
114 ModSeq Page A x
115 ModSeq Page B x
116 ModSeq Page C x
117 ModSeq Page D x
118 ModSeq RndIso x
119 ModSeq Speed x
120 ModSeq loop x
121 ModSeq Power x
122 ModSeq LoopStart x
123 ModSeq LoopEnd x
124 ModSeq Xval x X Val Mod Seq Input
125 ModSeq Yval x Y Val Mod Seq Input
126 < Reserved > x For modseq playhead position.
127 Solo/Mute mode x
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